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1
Overview of 
Expression

Even if you are experienced with 
vector-based graphics applications, 
this chapter will familiarize you with 
Expression’s interface and basic 
functions. If you are anxious to get 
started, you can skip this chapter 
and use it as a pictorial reference 
for tools and palettes. The tutorial 
in Chapter 2 can be used to 
acquaint you with most of 
Expression’s tools and techniques.
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Starting Expression

The first time you start Expression, you are 
asked for your serial number.

The serial number is located on the “Read 
This First” card and the Registration card.

To start Expression on a Macintosh:

Double-click the Expression icon. The 
Expression tools and palettes appear.

Choose the New File button from the 
Standard toolbar to open a new 
document. You can also choose 

.

Choose the New File button.

To start Expression in Windows:

Choose 

or double-click the 
Expression icon. The Expression tools 
and palettes appear.

Choose the New File button from the 
Standard toolbar to open a new 
document. You can also choose 

.

Choose the New File button.

How an Expression Image 
is Made

Like most drawing software programs, 
Expression’s objects are comprised of 
paths. A path is a sequence of points 
(nodes) connected together as lines or 
curves. Expression allows an arbitrary mix-
ture of straight-lines, Bézier curves and 
B-Spline curves linked together to form a 
path. 

Each path is assigned a stroke and a fill. 
Stroke refers to the outline or edge of an 
object. Picking a stroke in Expression is 
similar to picking up an artist’s brush.

Fill refers to the inside color or pattern. 
Expression combines the stylistic expres-
siveness of paint, brush strokes and other 
traditional artists’ tools with the flexibility, 
speed, edibility and resolution indepen-
dence of an advanced, vector based draw-
ing application.

Vector path.

Vector path with stroke.
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Vector path with stroke and fill.

Most drawing programs are limited to the 
attributes which can be assigned to strokes 
and fills. Expression removes this limita-
tion. With Expression, you can designate 
any vector picture as a stroke. This Skeletal 
Stroke™ technology can be applied to 
boxes, text, freeform shapes, lines—any-
thing you can create in Expression.

Expression uses three types of Skeletal 
Strokes:

• Natural-Media strokes

• Graphic Element strokes

• Multi-view strokes

Natural-Media Strokes
These strokes mimic traditional artist tools 
such as paint brushes, pencils and pens.

Natural-Media stroke.

Graphic Element Strokes
These strokes contain vector drawings and 
objects. You can create a stroke out of any 
vector graphic. 

Graphic Element stroke.

Multi-View Strokes
Multi-view strokes incorporate both Natu-
ral-Media and graphic elements and consist 
of two or more related pictures. Expression 
automatically creates additional views in 
between those you start with, allowing you 
to quickly create related but non-identical 
images. 

As you can see in the examples, Expression 
creates in between views showing varying 
degrees of each element. Each time you 
apply a Multi-view stroke, you can specify 
which view is displayed or let Expression 
create them randomly. Multi-view strokes 
can also be saved as animations (Quick-
Time for Macintosh or AVI for Windows).

Multi-view stroke of Natural-Media.

Multi-view stroke of a Graphic Element.
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Dip Right In!

Since we know you are anxious to get 
started, we’ll introduce you to Expression 
at its most basic— creating a path and 
assigning a stroke.

Expression interface.

Try this:

Choose  to open a new 
document.

Scroll through the Stroke Warehouse 
palette to preview the hundreds of pre-
designed stokes available in Expression.

Click on a stroke to select it.

Stroke Warehouse palette

Select a stroke from the Stroke Warehouse 
palette.

Choose the Freehand tool from the Tools 
toolbar.

Choose the Freehand tool.

Using the Freehand tool, draw a path. 
The stroke you selected is applied to the 
path you created!

That’s all there is to it. Take some time to 
experiment with some of the other draw-
ing tools.

Expression’s Interface

Expression’s interface consists of several 
types of toolbars and palettes. Some of the 
toolbars and palettes open automatically 
when you launch Expression. You can hide, 
display or move any or all of the toolbars 
and palettes on your workspace to meet 
your particular working style. Each of the 
toolbars is explained later in this chapter. 
First we will show you how to select and 
arrange toolbars in the Expression work-
space.
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The Toolbars

When you launch Expression some tool-
bars are displayed along the top and left 
side of the window.

Moving and Resizing Toolbars
To change the location of a toolbar, click-
drag in the gray toolbar frame area. Drag 
the toolbar to the middle of the window to 
let the toolbar float or drag a floating tool-
bar to the top, bottom, left, or right edge of 
the screen to dock the toolbar.

Moving your toolbars

The floating toolbars can be resized by 
dragging at the corners. Reposition a float-
ing toolbar by dragging its title bar.

Resizing your toolbars.

Displaying Toolbars 
Expression allows you to customize your 
workspace by displaying the tools you use 
the most and hiding those you use less fre-
quently. 

To select which toolbars are displayed:

Choose . 
The Toolbars dialog appears. Toolbars 
currently displayed on your workspace 
have a check mark in front of their name.

The Toolbars dialog.

Click to select or deselect the toolbars 
you want to display.

Click OK. All selected toolbars appear on 
the workspace. You can resize and move 
toolbars as needed.

The Standard Toolbar
The Standard toolbar contains buttons for 
basic File menu commands. Choose 

:  to tog-
gle the Standard toolbar on and off. The 
Standard toolbar contains the following 
buttons:

The Standard toolbar.

New File

Creates a new Expression document.

Open File

Opens the standard Open dialog, allowing 
you to open an existing Expression docu-
ment or graphics file. To limit file type to a 
specific file format, select the preferred 
type from the Format or Files of Type field.
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Save File

Saves the current document to hard drive, 
floppy diskette, or other selected media.

Print

Displays the standard Print dialog, allowing 
you to print the current document. 

Cut

Removes selected object(s) from the work-
space and saves the selection to the Clip-
board until another selection is cut or 
copied. 

Copy

Copies selected object(s) to the Clipboard 
and saves the selection until another selec-
tion is cut or copied. 

Paste

Inserts information previously stored in the 
Clipboard into the document.

The Composition Toolbar
The Composition toolbar contains buttons 
that allow you to edit your document by 
clicking rather than using command key-
strokes. Choose 

:  to toggle the 
Composition toolbar on and off. The Com-
position toolbar contains the following but-
tons:

The Composition toolbar.

Select All

Selects all objects in the current document.

Deselect All

Deselects all objects in the current docu-
ment.

Delete Selection

Deletes all selected objects. The objects 
are not stored in the Clipboard. However, 
you can use Expression’s Undo function to 
return the deleted selection.

Up One

Moves the currently selected object up one 
level in the stack order of the current layer.

Down One

Moves the currently selected object down 
one level in the stack order of the current 
layer.

To Top

Moves the currently selected object to the 
top level of the stack on the current layer.

To Bottom

Moves the currently selected object to the 
bottom level of the stack on the current 
layer.

 Note: Objects on the top draw last and 
therefore are not obscured by any other 
objects. Objects on top appear to be in 
front of any other objects on the same 
layer.
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Tools Toolbar
The Tools toolbar contains tools for basic 
object drawing and manipulation. Choose 

:  to tog-
gle the Tools toolbar on and off. For more 
information regarding the Tools toolbar 
see ➤Chapter 6, “Arranging and Editing 
Objects.” 

The Tools toolbar contains the following 
tools:

The Tools toolbar.

Selection Tools 

The Selection tools.

The Object Selection and Group Selection 
tools allow you to select individual objects 
or groups of objects.

Object Selection Tool

Selects objects or groups of objects.

Group Selection Tool

Selects an individual object within a group. 
Clicking again on the object selects the 
entire group.

Node Tools 

The Node tools.

The Node Selection and Convert Node tools 
are used to select and edit points within an 
object. Nodes are vector points used to 
define a path.

Node Selection Tool

Selects points on a path.

Convert Node Tool

Converts the characteristics of points from 
corner to curve or vice-versa.

Path Tools

The Path tools.

The Add Node, Delete Node, Split Path, 
Reverse Path and Change Start Point tools 
are used to alter the path of a selected 
object. In order to use these tools the path 
must be selected.

Add Node Tool

Adds a new point along a selected path.

Delete Node Tool

Removes a point from selected path.

Split Path Tool

Cuts the path into two segments.
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Splitting a path, before and after.

Reverse Path Tool

Reverses the direction of the path and its 
Skeletal Stroke, if any.

Reverse path, before and after.

Change Start Point Tool

Relocates the starting point for the path, 
moving the starting point of any Skeletal 
Stroke to the new location.

Change Start Point, before and after.

Grabber Tool 

Provides an alternative way to scroll an 
image. Click in the workspace and drag to 
move the page.

Magnifier Tool 

Allows you to magnify areas of an image 
when you are performing detailed work, or 
reduce your workspace to get an overall 
view of an image. Click to zoom in, or hold 
the Option/Alt key and click to zoom out. 
You can also drag a marquee to zoom into a 
specific area.

Classic Drawing Tools

The Classic Drawing tools

These tools are used to draw freeform 
shapes. After creating paths, you can use 
the Path tools (described above) to edit 
any path. For additional information 
regarding the drawing tools, see 
➤Chapter 3, “Creating Paths.”

Freehand Tool

Creates shape paths by drawing freehand 
lines.

Freehand path.

Pen Tool 

Creates shape paths using standard Bézier 
points.
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Pen path.

Supplemental Drawing Tools

The Supplemental Drawing tools.

Expression’s Polyline, B-Spline and 
Smoothed Polyline tools provide additional 
ways of creating paths. These are espe-
cially useful for creating stylized artwork.

For more information regarding these 
tools, see ➤“Drawing Tools” in Chapter 3, 
“Creating Paths.”

Polyline Tool

Draws straight line and circular arc line 
segments.

Polyline path.

B-Spline Tool

Draws smooth curves based on straight 
line control polygon.

B-Spline path.

Smoothed Polyline Tool

Draws curved line segments.

Smoothed Polyline path.

Line Tool

Draws straight lines. Hold down the Shift 
key to constrain your line to 45° incre-
ments. For information on setting the angle 
of constraint, see ➤“Setting Preferences,” 
later in this chapter.

Line object.

Shape Object Tools 

The Shape Object tools.

These tools are used to draw rectangles, 
squares, ellipses (ovals) and circles.
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Rectangle Tool

Creates rectangles and squares. Hold down 
the Shift key to constrain the object to a 
square.

Ellipse Tool

Creates ellipses or circles. Hold down the 
Shift key to constrain the object to a circle.

Text Tool

Creates text objects. Text objects can be 
applied to a path. Each letter can be 
assigned a distinct stroke and fill. Text can 
be converted to a path so you can edit the 
shape of each letter. For more information 
on working with text, see ➤Chapter 3, “Cre-
ating Paths.”

Gradient Tool

Controls the direction and rate of change 
for a gradient stroke or fill.

Objects containing gradients.

Dropper Tools 

The Dropper tools

These tools allow you to quickly copy color 
or stroke and fill attributes from one part of 
your artwork to another.

Color Dropper Tool

Picks up color from one object, or area of 
an object, so you can drop the color onto 
another object or area. 

Attribute Dropper Tool

Picks up the stroke and fill attributes from 
one object, so you can drop the attributes 
onto another object.

Transformation Tools 

The Transformation tools.

These tools are used to transform selected 
objects by rotating, scaling, mirroring, 
shearing, or applying perspective. For 
more information regarding the Transfor-
mation Tools, see ➤“Transforming 
Objects” in Chapter 6, “Arranging and Edit-
ing Objects.”

Rotation Tool

Allows you to rotate selection. Click to set 
the center of rotation, then click-drag to 
rotate selection.

Scale Tool

Allows you to change the size of selected 
object. Click to set the anchor for the scal-
ing, then click-drag to scale selection. 

Mirror Tool

Allows you to create a mirror image of the 
selected object. Click to set the center for 
the reflection, then click-drag to mirror the 
selection.
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Shear Tool

Allows you to shear or skew the selected 
object. Click to set the center for the shear, 
then click-drag to skew the selection. For 
more information regarding the Shear tool, 
see ➤“Shearing Objects” in Chapter 6, 
“Arranging and Editing Objects.”

Perspective Tool

Allows you to apply a perspective effect to 
any selected object(s). This tool has two 
modes. In the first mode, an object is 
framed in preparation for applying per-
spective. In the second mode, drag the cor-
ners of the frame to apply perspective.

When the perspective tool is first selected, 
it is in the framing mode. Drag the four 
small corner handles to set the perspective 
frame. Then click once off the object to 
switch to perspective mode; The handles 
become larger. Drag the handles to apply 
perspective.

Before and after perspective.

Definition Tools 

The Definition tools.

These tools are used to define Skeletal 
Strokes as well as Patterns to use as fills. 
For more information regarding these 
tools, see ➤“Creating and Editing Skeletal 
Strokes” and ➤“Applying Pattern Fills” in 
Chapter 5, “Applying Strokes and Fills.”

Stroke Definition Box

Opens the Stroke Definition window, allow-
ing you to create a Skeletal Stroke. Choose 
the Stroke Definition Box tool and drag a 
marquee around the artwork you wish to 
use as a Skeletal Stroke. The Stroke Defini-
tion window opens. To complete the 
stroke, click the Define button at the bot-
tom of the window. Give your stroke a 
name.

Pattern Definition Box

Allows you to define a new pattern from 
any artwork in the current document. 
Choose the Pattern Definition Box tool and 
drag a marquee around the artwork you 
wish to use as a Pattern. The artwork 
within the marquee is repeated as a pat-
tern. To complete the pattern, click the 
Define button at the bottom of the window. 

Give your pattern a name. If you decide you 
don’t want to define the pattern press the 
Delete/Backspace key while the pattern 
box is selected.

Anchor Tool/Repeat Tool

The Anchor/Repeat tools.

These tools are used to control the behav-
ior of particular parts of a Skeletal Stroke 
and are available only when the Stroke Defi-
nition window is active. As a Skeletal Stroke 
is applied to a path it can be useful to have 
certain parts maintain their original pro-
portions, while other parts of the same 
stroke are stretched along the path. Like-
wise, it can be useful to specify that certain 
parts should repeat along the path, rather 
than stretch.

For more information regarding these 
tools, see ➤“Using Anchoring” and 
➤“Repeating Elements of a Stroke” in 
Chapter 5, “Applying Strokes and Fills.”

Anchor Tool

Allows you to anchor selected points so 
they remain a constant proportion when a 
Skeletal Stroke is applied to a path. This is 
used when you want specific parts of a 
Skeletal Stroke to maintain their original 
proportions. For example, the dog stroke 
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below is defined with the head and tail 
parts anchored to the beginning and end-
ing points of the stroke. The section 
between the two anchored areas can 
stretch on any long path but the tail and 
head remain the same.

Anchoring parts of a stroke.

To use this feature you must first use the 
Stroke Definition Box tool to select art-
work that will be used as a stroke.

Repeat Tool

Allows you to define selected objects to 
repeat rather than distort as Skeletal Stroke 
is applied to path. For example, you might 
create a train with an engine, a passenger 
car and a caboose. Anchor the engine to 
the beginning point and the caboose to the 
ending point. Then define the passenger 
car as repeating. The length of path to 
which you apply such a stroke determines 
how many passenger cars are contained in 
your train.

Repeating parts of a stroke.

The Actions Toolbar
The Actions toolbar includes controls for 
the behavior of node tangent handles as 
well as the Ellipse Closure controls, Anchor 
and Repeat controls and the Pressure Sen-
sitivity buttons. Choose 

:  to toggle the Actions 
toolbar on or off. The Actions toolbar con-
tains the following buttons:

The Actions toolbar

Node Continuity Controls

The Node Continuity controls.

A pair of tangent handles is attached to 
each Bézier node on a path. The position of 
the tangent handles controls the shape of 
the path between nodes. Nodes that are 
corner points have their tangent handles 
retracted so you can not see them. 

The Node Continuity buttons determine 
how selected nodes and handles are con-
trolled when editing. Select a node then 
click the preferred Node Continuity button. 
For more information regarding Node Con-
tinuity see ➤“Selecting and Moving Points” 
in Chapter 6, “Arranging and Editing 
Objects.”
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Symmetrical

Positions the tangent handles so they are 
opposite each other and equidistant from 
the node.

Smooth

Positions the tangent handles so they are 
opposite each other. In this case, changing 
the distance from the node of one handle 
does not change the distance of the other. 

Angle Locked

Positions the tangent handles so they are 
locked in relation to each other. Moving 
one handle causes the other handle to 
move the same angular distance and direc-
tion.

Unconstrained

Allows tangent handles to move indepen-
dently of each other.

Unconstrained tangent handles.

Ellipse Closure Controls

The Ellipse Closure controls.

These buttons allow you to control how an 
open ellipse is closed. Expression’s ellipse 
is a special case object. After creating an 
ellipse you can drag its single point with 
the Select Node tool to open it up, then use 
one of the following buttons to complete 
the shape. For additional information 
regarding the Ellipse Closure Controls, see 
➤“Editing Ellipses” in Chapter 6, “Arrang-
ing and Editing Objects.”

Open Arc

Allows you to create an open ellipse line 
segment.

Ellipse as an arc.

Pie

Allows you to create an ellipse line segment 
closed by a pair of straight lines. These 
lines connect with each other in the center 
of the ellipse.

Ellipse with pie line segments.

Add Chord

Allows you to create an ellipse line segment 
with a flat side. The ellipse is closed by a 
straight line segment from beginning point 
to ending point.

Ellipse with a chord line segment.
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Anchor Controls

The Anchor controls.

These tools are only available if the Anchor 
tool has been used to select anchor points 
in the Stroke Definition window. Use the 
Anchor Control tools to control the behav-
ior of anchored points. 

Within the Stroke Definition window, use 
the Anchor tool to drag a marquee to select 
the points you want to anchor. Then, click 
the Anchor Control that describes the type 
of anchor you wish to apply to the selected 
nodes. For additional information regard-
ing Anchor Controls, see ➤“Using Anchor-
ing” in Chapter 5, “Applying Strokes and 
Fills.”

Anchor at Start

Constrains selected points to the start of 
the Skeletal Stroke as it is applied to a path. 

Anchor at End

Constrains selected points to the end of the 
Skeletal Stroke as it is applied to a path.

Anchor at Fixed Point

Constrains selected points to a specific 
part of the Skeletal Stroke as it is applied to 
a path.

Free Anchor

Removes anchor constraint from selected 
point.

Repeating Control

The Repeating Control tools.

These tools are only available if the Repeat 
tool has been used to select objects to 
repeat in the Stroke Definition window. Use 
the Repeating Control tools to control the 
behavior of repeating objects. 

Within the Stroke Definition window, use 
the Repeat tool to select the objects you 
want to repeat. Then, click the Make 
Repeating button to make the selected 
objects repeating or click the Make Non-
repeating button to remove the repeating 
function from the selected objects. For 
additional information regarding Repeat-
ing Controls, ➤“Repeating Elements of a 
Stroke” in Chapter 5, “Applying Strokes and 
Fills.”

Make Repeating

Repeats the selected objects within the 
stroke based on length of path.

Make Non-repeating

Removes the repeating function from the 
selected objects. 

Pressure Sensitivity Controls 

The Pressure Sensitivity Controls

These buttons toggle pressure sensitivity 
on or off. These functions are only available 
when a pressure sensitive drawing tablet is 
used instead of a mouse.

Pressure sensitivity applies only to the 
Freehand tool.

Disable Pressure Sensitivity

Allows a pressure sensitive graphics tablet 
to behave just as a mouse device.
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Enable Pressure Sensitivity

Allows you to vary the width of a Skeletal 
Stroke based on the amount of pressure 
applied when using a pressure sensitive 
graphics tablet. Strokes appear thin where 
light pressure is applied, and thicker where 
heavy pressure is applied.

Miscellaneous Toolbar
The Miscellaneous Toolbar controls Blend-
ing and Boolean operations (also known as 
pathfinder operations to Adobe Illustrator 
users). 

Choose :
 to toggle the Miscellaneous 

toolbar on or off. For additional informa-
tion regarding Blending Paths ➤“Blending 
Paths” in Chapter 3, “Creating Paths.” For 
more information regarding Boolean Oper-
ations, see ➤“Using Boolean Operations” in 
Chapter 3, “Creating Paths.” The Miscella-
neous toolbar contains the following but-
tons:

The Miscellaneous toolbar.

Blend Paths

Creates a series of new paths based on two 
selected paths.

Blend Paths, before and after.

Union

Creates a new path based on the outline of 
all selected source paths as if they were 
merged into one object. Paths inside are 
ignored.

Union, before and after.

Front-Back

Creates a new path that contains areas in 
the front path that are not overlapped by 
areas in the back path.

Front-Back, before and after.



16 Fractal Design Expression User Guide

Back-Front

Creates a new path that contains areas in 
the back path that are not overlapped by 
areas of the front path.

Back-Front, before and after.

Intersection

Creates a new path that contains areas 
where the selected source paths overlap. 
Areas and paths that do not overlap are 
ignored.

Intersection, before and after.

The Palettes

Expression uses a variety of palettes to 
control specific functions. Most of these 
functions are not available elsewhere in 
Expression. You will find that certain pal-
ettes are so crucial to your work that you 
will always want them open.

Some palettes include tabs that open addi-
tional layers of the palette. Clicking a tab 
brings specific information forward so you 
can select options relating to the particular 
function listed on the tab.

A palette with tabs.

Use the close button in the title bar to hide 
unused palettes. The title bar also contains 
the name of each palette. Drag the title bar 
to move the palette on the screen.

Close Box

Tabs

Displaying Palettes
The Window menu contains the name of 
each palette available in Expression. To 
open a palette, choose a palette name from 
the Window menu. A check mark appears 
next to open palettes. 

Check marks appear next to open palettes.

Rather than describe each palette in depth 
here, we will refer you the chapter that 
explains each palette in detail.
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Paint Style Palette
This palette controls how your path is dis-
played including stroke, fill and color. Use 
the Paint Style palette to assign the stroke 
and fill you prefer. 

Your stroke may be none, Basic (a fixed 
width with solid color), Gradient (a fixed 
width with gradient color) or a Skeletal 
Stroke. Use the Stroke tab to select the 
style of stroke you prefer.

Select a stroke style.

Your fill may be none, a plain color, a gradi-
ent or a pattern. Use the Fill tab to select 
the style of fill you prefer. For more infor-
mation regarding stroke and fill see 
➤Chapter 5, “Applying Strokes and Fills.”

No Stroke Basic Gradient Skeletal

Select a fill style.

The Colorize tab of the Paint Style palette 
gives you several ways of controlling the 
colors used in your strokes. Changes made 
in this area affect all selected objects and 
any new path you draw while the same 
Skeletal Stroke is selected. For more infor-
mation regarding Colorize, see ➤“Coloriz-
ing Objects” in Chapter 4, “Using Color.”

No Fill Color Gradient Pattern

Use the Colorize tab to adjust the colors 
within a Skeletal Stroke.
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Color Palette 
This palette controls the use of colors. 
When you set the stroke and/or the fill to 
plain color or a gradient, you can then use 
the Color palette to select colors. 

Select a color model, then enter a color 
value (RGB and CMYK) or click on the color 
wheel to see the range of colors available in 
the Value Picker (HSL). For specific infor-
mation regarding color and gradients see 
➤“The Color Palette” in Chapter 4, “Using 
Color.”

The Color palette.

Color Table

Color Selection

Click to 
expand palette

Attribute buttons

Current Color

Custom Color Palette 
This palette contains a list of custom colors 
which you can apply to any document. For 
more information regarding custom color, 
see ➤“Using Custom Colors” in Chapter 4, 
“Using Color.”

The Custom Color palette.

Stroke Warehouse Palette 
This palette contains a selection of pre-
designed Natural-Media, Graphic Element, 
and Multi-view strokes. Each stroke can be 
thought of as a customized brush. Strokes 
can be applied to any path in Expression. 
For more information about the Stroke 
Warehouse palette see ➤Chapter 5, “Apply-
ing Strokes and Fills.”

The Stroke Warehouse palette.

Panner Palette
Use this palette to quickly reposition your 
page so you can draw in a manner that is 
comfortable for you. Click the side arrows 
to rotate the page clockwise or counter-
clockwise. Click the plus or minus button 
to move the page forward or backward.

The Panner palette, Windows and Macintosh 
versions.
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Font Palette
Use this palette to select the font and other 
attributes for Text objects. For more infor-
mation regarding Text, see ➤“Creating 
Text” in Chapter 3, “Creating Paths.”

The Font palette. 

Transformation Palette 
Use this palette to translate (move), rotate, 
shear, mirror or scale objects. Use the 
small arrows to the right or left of the tabs 
to display additional tabs as you need 
them. Click Apply to apply your changes to 
any selected object. Use the Duplicate but-
ton instead of the Apply button to create a 
duplicate of the selected object as you 
transform it, leaving your original object 
untouched. For more information on trans-
formation, see ➤“Arranging Objects” in 
Chapter 6, “Arranging and Editing Objects.”

The Transformation palette.

Alignment Palette
Use this palette to align, distribute or stack 
objects. For more information on Align-
ment, see ➤“Aligning Objects” in 
Chapter 6, “Arranging and Editing Objects.”

The Alignment palette.

Layers Palette
Use this palette to add, delete, select, 
name, lock/unlock or hide/show layers. For 
more information on Layers, see ➤“Layer-
ing Objects” in Chapter 6, “Arranging and 
Editing Objects.”

The Layers palette.

Gradient Editor Palette
This palette can be used to add, delete and 
edit gradients. For more information on 
gradients, see ➤“Using Gradients” in 
Chapter 4, “Using Color.”

The Gradient Editor palette.
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Getting Acquainted with 
Expression’s Workspace

This section outlines how to customize the 
workspace to match your own style of 
work. You’ll learn how to use Grids and Rul-
ers and how to set your preferences. 

Creating a New Document
To create a new document choose 

 or Command/Ctrl+N or click 
the New File button on the Standard tool-
bar.

New Expression document.

Workspace
Use the scroll bars on the right and bottom 
of the document to move the page. The 
workspace is larger than the page that 
prints so be careful to keep your artwork 
inside the page outline if you want it to be 
part of your printed document. 

Use the remainder of the space as a desk-
top or drawing board. For example, you 
might work off the page when creating new 
strokes. Then work on the page when 
applying the stroke to a path as part of 
your image.

The Expression workspace.

Scroll bar

Zoom Ratio box

Document window

Sizing Your Workspace
After you create a new document, you can 
set the size of your page, page orientation 
and unit of measurement to accommodate 
the size of the drawing you are going to 
create.

To adjust the size of your workspace:

Choose . 
The Document Setup dialog appears.

Windows Document Setup dialog.
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Macintosh Document Setup dialog.

Click on the pop-up next to the Width 
and Height controls to display and select 
a unit of measurement.

Select or enter the size for your page and 
the orientation of the page.

Click OK. The size of the workspace in 
the current document changes to reflect 
your selections.

Rulers
The document window includes rulers on 
the top and left side. As you move the cur-
sor around the window a line on each ruler 
indicates the cursor position. You can 
change the rulers from the default inches 
to pica or points by clicking the small box 

at the upper left corner. You can toggle the 
rulers by choosing 

.

You can also scroll the view by placing the 
cursor on the vertical or horizontal ruler. 
When the cursor changes to a hand, drag to 
scroll the view.

Click to change the ruler measurements.

Grid and Node Constraints
Expression provides you with a grid to aid 
in arranging objects. To toggle the grid on 
or off choose . 

For information on setting the size of the 
grid see ➤“Setting Preferences,” later in 
this chapter.

When  is 
active, all drawing and editing tools (except 
the Freehand tool) are influenced by the 
grid. When you click or drag near a grid line 
or intersection, the cursor snaps to the 
grid. The snap is stronger at grid intersec-
tions than along grid lines.

Expression also provides a snap to node 
constraint by using 

. When you click or drag near an 
existing node (point), the cursor snaps to 
the node.

The Status Bar
At the lower left corner of the Expression 
window is the Status Bar. The Status Bar 
displays information regarding the Snap To 
Grid or Snap to Node functions and the size 
of the Grid as set in the Preferences dialog 
View tab.

Choose :
s to toggle on/off the Status Bar at the 

bottom of the main Expression window.

The Expression status bar.

Multiple Windows
You may have multiple document windows 
open while you are working in Expression. 
The Window menu provides a list of cur-
rently open Expression documents. If you 
have multiple documents open, choose the 
name of a document from the Window 
menu to bring the document to the fore-
ground and make it the active document.

The Window menu also allows you to con-
trol how multiple windows are displayed. 
These functions are only available on the 
Windows platform.
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Choose  to 
arrange open windows starting in the 
upper left corner with each additional win-
dow positioned slightly to the right and 
lower so you can see the title bar of each 
window.

Choose to arrange 
open windows as tiles.

Choose  
to arrange open minimized windows along 
the bottom of the screen.

Navigating Your 
Document

You can navigate through a document or 
image by changing the level of magnifica-
tion (zooming in or out), scrolling to a dif-
ferent part of the image, or rotating the 
page. By navigation, we mean moving 
around a document, changing views, or 
moving the page.

Zooming In and Out
By default Expression opens a document at 
100% view, but you can change the view to 
suit your needs. The Zoom Ratio box in the 
lower left corner of the document displays 
the current zoom ratio. Click-hold to 
choose another zoom ratio.

The View menu also offers you a variety of 
ways of changing the zoom ratio: 

Zoom in Enlarges the document window 
to the next largest zoom ratio.

Zoom out Reduces the document window 
to the next smallest zoom ratio.

Zoom on Selection Magnifies and centers 
the current selection to fill the document 
window.

View All Reduces the page to view all 
objects in the document window.

Actual Size Enlarges or reduces the docu-
ment window to 100% size.

Center View Centers the printable page in 
the document window.

You can also zoom in and out with the 
Magnifier tool.

To zoom in:

Choose the Magnifier tool from the Tools 
toolbar. The cursor changes to a 
magnifier. The plus sign (+) on the 
magnifier indicates that you are 
increasing magnification—zooming in.
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Click with the Magnifier to view an image 
close-up.

Click the image. With each click, the 
image is magnified. The ratio of the 
magnification appears in the Status Bar 
at the bottom of the window.

To zoom out:

Choose the Magnifier tool from the Tools 
toolbar. The cursor changes to a 
magnifier.

Hold down the Option/Alt key. The plus 
sign (+) on the Magnifier tool turns to a 
minus sign (-).

While holding down the Option/Alt key, 
click the image. The magnification ratio 
appears in the Status Bar at the bottom 
of the window. 

To magnify a specific area:

Choose the Magnifier tool from the 
Tools toolbar. Move the cursor to the 
drawing window and drag a rectangle 
around the area you want to magnify. 

The area inside the rectangle is magni-
fied to the closest magnification level 
that fills the screen.

Using the Grabber Tool
The Grabber tool gives you a quick way to 
scroll an image.

To scroll by using the Grabber tool:

Choose the Grabber tool from the Tools 
toolbar. The cursor changes to the hand 
cursor.

Drag in the document window to pan or 
move your image.

To use the Grabber tool while another tool is 
selected, hold down the Spacebar.
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Changing Your View
In addition to controlling the Grid, Rulers, 
Snap To and Zoom Ratio the View menu 
controls the display quality for your paths.

Path Shows the path only.

The Path view displays only the paths.

Wireframe Shows the path plus an outline 
of any stroke applied to the path.

The Wireframe view displays the path plus 
outlines representing strokes.

Preview Shows the path plus the stroke 
and/or fill as applied to the path.

The Preview view displays the document as 
it would be printed.

Creating a New View
The View menu can also be used to open 
up an additional window showing a differ-
ent view of the document you are currently 
editing. This can be very useful when work-
ing on a complex image, as you can set 
each view window to its own zoom ratio. 

To open an additional view:

Choose . An 
additional view window displays the 
name of the current document in the title 
bar, followed by a number defining 
which view it represents. Actions 
performed in one view window are 
immediately shown in any additional 
views of the same document.

New View displays an additional window for 
working on the same document.
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Setting Preferences

Expression’s preferences enable you to 
customize Expression to the way you like 
to work. There are four tabs to take you to 
the specific areas you can customize.

To set Expression Preferences:

Choose . The 
Preferences dialog appears.

Preferences dialog.

Click the tab for the area you would like 
to edit, then make your changes.

Click OK.

Options Tab
This tab controls settings for various 
options including Tools, Objects, Arrange-
ment and Miscellaneous.

Tools

Drawing tools: append to path When this 
option is enabled (the default), all drawing 
tools (except the Freehand tool) can be 
used to append points to an existing path. 
Just position the cursor over the endpoint 
of an existing path before starting to draw. 
A tilde (~) is added to the cursor, indicating 
that it is ready to append points to the 
existing path.

When this option is disabled, none of the 
drawing tools append points to existing 
paths. Clicking on the endpoint of an exist-
ing path creates a new path starting at that 
point. By holding down the Shift key, you 
can force any drawing tool to append 
points to an existing path.

Freehand Tool: Tightness of fit Controls 
the precision with which the path follows 
the movement of the mouse or stylus pen 
when using the Freehand tool. If the setting 
is too high every minor waver is captured, 
possibly resulting in a line that is quite 
irregular. If the setting is too low the result-
ing path may be less precise than you 
intended. 

In most cases the default setting should 
give you acceptable results. 

Color Dropper: resets primaries This 
preference determines what happens when 
you use the Color Dropper tool to drop 
color onto an object whose colors have 
already been adjusted using the Fore-
ground/Background color swatches or the 
Colorize controls.

When this preference is enabled (the 
default), using the color dropper automati-
cally resets the Colorize or Foreground/
Background information. This ensures that 
the color you're dropping is the color you 
actually see on the object.

When the preference is disabled, the color 
you drop may not be the color you see on 
the object. For example, suppose you have 
a grayscale stroke with the foreground 
color set to red, so your entire stroke 
appears in reds of varying shades. Then 
suppose you use the color dropper to drop 
black into an area of your stroke which is 
currently medium red. The spot where you 
drop the color will not appear black, but 
instead will appear full red. This is because 
the red foreground color transforms all 
black regions within the stroke into red. 

For more information regarding colors, see 
➤Chapter 4, “Using Color.”

Objects

Quick (area) select Determines whether 
clicking on a fill area selects an object or 
whether you need to click on the path itself 
in order to select an object.
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Transform patterns Controls the way a 
pattern is handled when an object contain-
ing a pattern is transformed (rotated, 
skewed, scaled). When this option is 
enabled, the pattern is applied to the 
object before the transformation and there-
fore transforms with the object. When this 
option is disabled the object is transformed 
and then the pattern is reapplied and not 
affected by the transformation. 

Original object with pattern before transform.

Object after skew with Transform patterns 
ON, then OFF.

Path operations: keep originals Toggles 
on/off to keep or discard original objects 
after performing a Boolean operation. For 

information regarding Boolean operations, 
see ➤“Using Boolean Operations” in 
Chapter 3, “Creating Paths.”

Show resize handles Toggles on/off the 
on-screen resize handles that appear 
around selected objects. When on 
(default), resize handles are displayed at 
the corners of the bounding box and the 
transform handles appear on the top, bot-
tom and sides. 

Object selected with resize handles.

When off, the path itself appears in color 
but no handles appear. 

Object selected without resize handles.

Arrangement

Angular constraint steps Sets the angle of 
constraint when holding down the Shift key 
while moving or rotating an object.

Nudge increment Sets the increment 
applied when you use the keyboard arrow 
keys to move an object.

Stack: Gap Size Sets the size of the gap (in 
points) between objects when using the 
Stack function.

Miscellaneous

No fill with Skeletal strokes When this 
option is enabled, choosing a Skeletal 
Stroke automatically removes any fill which 
has been applied. If you want to fill an 
object which has a Skeletal Stroke applied, 
you can choose the stroke first, then apply 
a fill. 

When this option is disabled, the Skeletal 
Stroke uses whatever fill is active in the 
Paint Style palette. In most cases you prob-
ably do not want a fill with a Skeletal 
Stroke.

Undo levels Sets number of Undo levels. 
Higher levels of Undo use up more RAM. 

Color Match Tab
Use the Color Match tab to calibrate your 
monitor for the best match possible when 
printing to a color printer. For more infor-
mation on Color Match, see ➤“Setting 
Color Calibration” in Chapter 4, “Using 
Color.”
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Preferences dialog, Color Match tab.

View and Palettes Tab
This tab provides you options for the view 
displayed in your workspace and options 
for some of the palettes. These settings are 
applied when creating a new document.

Preferences dialog, View and palettes tab.

Grid

Snap to Grid  This option determines 
whether or not the Snap to Grid function is 
enabled when a new document is created.

Snap to Nodes When this function is 
enabled Expression automatically moves to 
the closest node on a selected path when 
you perform any action that applies to a 
node.

Show Grid Toggles on/off a non-printing 
grid that is useful for precise placement of 
points and objects. This option determines 
whether or not the Show Grid function is 
enabled when a new document is created.

Grid Spacing Sets the spacing/size for the 
grid in the workspace.

Color Palette

Draggable Color Wheel When this option 
is enabled, drag to rotate the Color Wheel. 
The color touching the point of the Value 
Picker triangle or diamond is the active 
color. When this option is disabled the 
Color Wheel is stationary and you click the 
desired color to make it active. The Value 
Picker reflects the current color selection.

Color Palette Border Sets the display for 
the Color palette with no border between 
colors in the Color Table, with black border 
between colors or with white border 
between colors. To display the Color Table 
in the Color palette you must expand the 
Color palette. For more information on 
expanding the color palette, see ➤“Color 
Palette,” earlier in this chapter.

No border

Black border

White border

Display Quality

Display Quality Determines the view 
Expression defaults to when a new docu-
ment is created. You can choose from Path, 
Wireframe or Preview views. For additional 
information regarding display quality, see 
➤“Changing Your View,” earlier in this 
chapter.

Greek limit (pts) Sets the minimum size 
for a font to be displayed on screen. Fonts 
smaller than this size display as gray lines 
rather than actual text.
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Stroke Warehouse

Animated stroke thumbnails Toggles on/
off the animation of stroke thumbnails in 
the Stroke Warehouse list. When this 
option is enabled, the Stroke Warehouse 
palette displays the currently selected 
stroke as an animation demonstrating how 
the stroke may appear when applied to a 
path. This is particularly useful for Multi-
view strokes. For more information regard-
ing Multi-view strokes, see ➤“Creating 
Multi-view Strokes” in Chapter 5, “Applying 
Strokes and Fills.”

Raster/Scratch Tab
This tab provides you the option for select-
ing a scratch disk and plug-in directory.

Preferences dialog, Raster/Scratch tab.

Scratch Disk

Use Select a disk that has plenty of free 
space. The scratch disk is used only when 
rasterizing. It should only be necessary 
when you do not have enough RAM to keep 
the entire rasterized image in memory.

Plug-Ins

Set Directory The only plug-ins Expres-
sion uses are file format input/output fil-
ters. By default, Expression looks for these 
plug-ins in its own plug-ins directory. The 
only time it is necessary to change this 
directory is if you have other PhotoShop-
compatible file format filters in another 
directory and want to use those instead of 
the filters supplied with Expression.

Opening and Saving 
Documents

Expression can open and use most vector-
based artwork. It can also save in most 
popular formats, both vector, such as 
Adobe Illustrator or CorelDRAW! and bit-
map such as Adobe Photoshop, TIFF (TIF) 
and BMP.

Vector or Bitmap
Computer graphics are either vector or bit-
map. A vector graphic is defined by placing 
nodes (or vector points), then using a 
mathematical formula to describe the line 
that connects the points. Vector artwork is 
also referred to as outline. 

The advantage of vector art is that it is reso-
lution independent and can easily be 
resized at any time, still printing out beauti-
fully on a Postscript printer. Drawing pack-
ages such as Adobe Illustrator, 
Macromedia FreeHand and CorelDRAW! are 
examples of vector-based graphics pro-
grams. 
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Vector images at different resolutions.

Bitmap images at different resolutions.

Bitmap artwork is defined pixel by pixel or 
dot by dot. Bitmaps have no outline, there-
fore, resizing such an image may result in 
stairstepped edges. 

Bitmaps have a real advantage when creat-
ing a textured look or for photographic 
quality images. Bitmaps can show subtle 
color changes and blends such as shadows. 
Graphics created by scanning, or by paint 
programs such as Fractal Design Painter 
and Adobe Photoshop, are examples of bit-
map artwork.

You can export artwork from Expression in 
either vector or bitmap format. If you want 
to place or edit your image in another 
application, while still retaining resolution 
independence, you should choose a vector 
format. If you want to refine it or generate 
color separations in a painting or image 
editing application, you should choose a 
bitmap format.

If your image contains transparent objects, 
you will need to save it in bitmap format 
(rasterized), since other vector-based 
applications and printers do not support 
transparency.

Always save a copy of your work in the Expression 
format (*.xpr). This will save your art in a vector 
format.

Setting Bitmap Resolution
When you save a file as a bitmap you can 
select the size and resolution of the file. 
Multi-view strokes saved as movies also 
have the same options. 

Resolution, in general, refers to the number 
of dots per inch (dpi) that make up an 
image. When you select a resolution, there 
are three kinds of resolution to consider:

• The monitor’s resolution, measured in 
pixels. Expression is preset to 72 pixels 
per inch. The resolution of your monitor 
may be different.

• The document’s resolution. You can 
assign the resolution when an image is 
scanned or an image is rasterized (saved 
as a bitmap) in Expression.

• The output device’s resolution, 
measured in dpi. Output device 
resolutions vary depending on the 
printer.

The default resolution setting is screen res-
olution or 72 dpi. The image on-screen at 
100% is the size it will be when it’s output. 
On most printers, 72 dpi bitmap renders a 
coarse image, so you may want to choose a 
higher resolution value.

If you are using a personal laser printer, set 
your bitmap Width and Height in inches, 
centimeters, points or picas. Set resolution 
to the dpi your printer supports. Your file 
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will be output correctly at the best resolu-
tion for your laser printer and at the proper 
size.

If you are using a commercial printer or a 
more sophisticated output device, the 
dimensions should always be set to the 
actual size it will appear in the printed 
piece. It’s a good idea to check with your 
service bureau if you have questions about 
output device resolution.

Opening Existing Documents
Artwork created in other software applica-
tions can be brought into Expression for 
continued editing. You might use imported 
artwork as the basis for a path, a Skeletal 
Stroke or a Pattern. You can use Expression 
to work with images already existing in the 
following formats:

Vector

• Adobe Illustrator 5.5 and earlier (*.ai)

• CorelDRAW! 3, 4, 5 and 6 (*.cdr)

• Computer Graphics Metafile (Windows) 
(*.cgm)

• Vector PICT (Mac)

• WMF (Windows)

• Fractal Design Expression (*.xpr)

To open or import an existing image:

Choose . The 
standard Open dialog appears.

The Open dialog.

Select the format or file type so you can 
limit the available files or select All Files.

Select the file you want to open then 
click Open. Expression opens a new 
document with the selected artwork.

Opening Clipboard Images

You can also use the Clipboard to bring art-
work from another application into Expres-
sion. Expression supports the following 
formats through the Clipboard:

• Vector PICT (Macintosh)

• WMF (Windows)

• Fractal Design Expression

• Text
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To open or import an existing image 
through the Clipboard:

Copy the artwork from its current file by 
selecting it and using the 

 or Command/Ctrl+C. This places a 
copy of the image into the Clipboard.

Paste the Clipboard image into the 
Expression document by using the 

 function or Command/
Ctrl+V.

Saving Documents
You can save your Expression artwork in 
several different ways:

• Expression format for use in Expression in 
a future session.

• Vector artwork for placement into a 
vector-based application such as Adobe 
Illustrator or CorelDRAW!.

• Bitmap artwork for placement into a 
bitmap application such as Fractal Design 
Painter or Adobe Photoshop.

• Movie format (Multi-view strokes only) 
for viewing an animation.

It is a good idea to always save your document in 
the Expression format (*.xpr). If you only save your 
art in a bitmap format, it will be harder for you to 
make changes to individual paths.

Saving as Vector

Your Expression artwork can be saved in 
the following vector-based formats:

• Fractal Design Expression

• Adobe Illustrator (*.ai)

• Computer Graphics Metafile (Windows) 
(*.cgm)

• CorelDRAW! Exchange (*.cmx)

• Vector-based PICT (Macintosh)

• WMF (Windows)

• EPS (This type of file stores only printer 
information. Expression EPS files cannot 
be edited.)

To save as vector:

Choose . 

If this is the first time you are saving the 
document you are prompted to select a 
file format, name and location.

If the file has been saved previously, 
choosing  replaces 
the last saved version with the current 
version.

To save and rename a document or to 
save and select a different format:

Choose .

Select the file format you prefer.

Assign a name to your file and select a 
directory in which to save it.

Click Save.

Saving as Bitmap

Expression allows you to save your artwork 
in the following bitmap formats:

• Adobe Photoshop 2.5

• TIFF/TIF

• Targa (Windows)

• PCX (Windows)

• PhotoPaint (Windows)

• Bitmap PICT (Macintosh)

• BMP

• JPEG (without LZW compression)
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Anti-Aliasing

Anti-aliasing is a process used to make 
color images appear smoother when the 
image includes curved and diagonal areas 
with high contrast. Without anti-aliasing 
the curves and diagonal lines may appear 
to be stairstepped. 

With and without anti-aliasing

With the Anti-Alias option enabled, Expres-
sion modifies areas with stairstepping, 
changing some pixels to intermediate col-
ors. For example, if your image is a red and 

yellow beachball on a blue background, 
individual pixels along the edge of the ball 
are changed to shades of orange and green, 
fooling the human eye into “seeing” a 
smoother curve. 

Unless you are working on a project which 
specifically requires that images not be 
anti-aliased, such as multimedia cast mem-
bers, there is no reason to disable the Anti-
aliasing option. Anti-aliasing does not sig-
nificantly increase the time required to ras-
terize an image.

To save as bitmap:

Choose .

Select or deselect Keep Proportions.

Set Width and Height in inches, 
centimeters or points. 

Set the Resolution of the bitmap. For 
more information on setting resolution, 
see ➤“Setting Bitmap Resolution,” earlier 
in this chapter.

Select or deselect Anti-Alias as needed. 
For information on anti-aliasing, see the 
introduction to this section.

Click OK.

Select a directory in which to save the 
bitmap file. Set the file format and name 
the bitmap file.

Click Save. Converting vector artwork 
into raster artwork will take some time. 
Expression displays a progression bar to 
let you know how much of the 
conversion has been completed.

High-resolution bitmap images require 
large amounts of disk space. If you have 
trouble saving a large bitmap, make sure 
you have sufficient free space on your 
hard disk.

Saving Multi-view Strokes As 
Movies
A Multi-view stroke can be rasterized, then 
saved as an animation or as a series of bit-
mapped still images. The animation can 
then be used in another application as a 
movie. For more information on Multi-view 
strokes, see ➤Chapter 5, “Applying Strokes 
and Fills.”

Multi-view Strokes

When rasterizing Multi-view strokes the 
goal is to produce a sequence of bitmaps to 
make up an animation. To achieve this, 
more parameters are required. Based on 
the number of frames per second (fps) and 
the duration of the movie, Expression can 
rasterize the appropriate number of bit-
maps. 

You must be in the Stroke Definition win-
dow and have open a Skeletal Stroke with 
two or more views.
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Movie files can take up several megabytes 
of hard drive space, since they are essen-
tially sequences of many images (poten-
tially hundreds). The following factors 
contribute to the size of a movie: frame size 
(height x width), frame rate (frames per 
second), duration (in seconds), and com-
pression settings.

Not only do large movies take up a lot of 
space on your hard disk; they also tend to 
play very sluggishly on all but the fastest 
computers. You should experiment with 
the variables listed above to determine 
which settings produce movies that play 
smoothly on your computer and take up 
reasonable amounts of storage space. 
Below are some general guidelines which 
may help you. For more detailed informa-
tion, consult the documentation that came 
with your multimedia authoring or video 
production software or hardware.

For video to be exported to tape and 
played back on television: 640 x 480 pixels, 
30 fps, save as sequenced images, Quick-
Time, or AVI with no compression (most 
video production software and hardware 
solutions provide their own compression).

For multimedia productions to be played 
on a typical desktop computer: 320x240 
pixels, 15 fps, save as QuickTime or AVI 
with moderate compression.

For web animation: Lower resolution, a 
small, fixed number of frames, save as 
sequenced JPEG images with compression. 
If you require GIF images, you will need to 
convert to GIF in another application.

To save an animation:

Open a Multi-view stroke by double-
clicking it in the Stroke Warehouse 
palette. The Stroke Definition window 
appears.

Choose 
.

Select or deselect Keep Proportions.

Set Width and Height in inches, 
centimeters or points. 

Set the Resolution of the bitmap. For 
information on setting resolution, see the 
guidelines in the introduction to this 
section.

Select or deselect Anti-Alias. For 
information on anti-aliasing, see ➤“Anti-
Aliasing” earlier in this chapter.

Set the Movie Length and Frames per 
Second.

Click OK.

Select file destination and name the file.

Click the Options button to set 
compression settings, if desired.

Click Save. The status area indicates 
progress as the movie is rasterized.

A movie player is required to view your 
movie. Macintosh documents are saved as 
QuickTime movies. Windows documents 
are saved as AVI movies.

Undoing Operations
Multiple Undo allows you to undo and redo 
actions within Expression. This gives you 
the freedom to experiment freely without 
fear of making mistakes. 

The number of undos is set in the Prefer-
ences found under 

. The default setting is ten 
levels. For more information on setting 
your preferences, see ➤“Options Tab” ear-
lier in this chapter.

To Undo an action:

Choose  or 
Command/Ctrl+Z.
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To Redo an action:

Choose   
Command/Ctrl+Y.

It is a good habit to save your file fre-
quently so you can choose 

 if you don’t like the 
changes.

Reverting to the Last Saved 
Version
Occasionally you will find it useful to revert 
to the last saved version of your file. This is 
especially useful if you have experimented 
with changes but decide you don’t want to 
keep the changes after all. You can also use 
the Undo/Redo function but there are some 
functions which can not be undone. If you 
save your file just before such an action 
you can revert to the last version saved if 
you decide you don’t like the changes.

To revert to last saved version:

Choose . 
Expression asks you to confirm that you 
want to revert to the last saved file.

Click Revert and Expression replaces the 
document with the last version saved on 
disk.

Closing Documents and 
Quitting

You can quit and close Expression docu-
ments the way you do in other programs.

To end a work session:

Close a document by choosing 
 or Command/Ctrl+W or 

clicking the close box in the upper left 
corner of the document (Macintosh) or 
the upper right corner of the document 
(Windows). 

If you have any unsaved changes, a dia-
log asks if you want to save changes. 
Click Yes to save your changes or No to 
discard them.

Exit Expression by choosing 
 (Macintosh) or 
 (Windows) or Command/

Ctrl+Q.


